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The Table of Contents gives the reader a comprehensive
overview of what topics or chapters that your manuscript
has, as well as the page number each chapter begins with.
These are most common in print - electronic documents
have started to adapt this principle as well.

PRO TIP
FRONT MATTER
- TABLE OF CONTENTS

HOW TO USE THIS BOOK
Congratulations!

You have finished your manuscript and have
decided to self-publish your book. We have taken our 28 years of expertise
and developed an easy to use guide to take you through the world of selfpublishing.
This guide is a reliable, practical, and straightforward reference guide for
you. Through common language (or defined if we found it questionable)
and conversational tone, this guide provides you with vital information
about self publishing and the best practices and tips you can use for any
style of books.
In addition to understanding the terms and
responsibilities you have as a self publisher, you will
learn the value of knowing terminology, tips and
information valuable to every self publisher. This will
give you the confidence to bring your book to life and
give you the maximum opportunity for success in your
new adventure.

Helping you, the author, have the
best experience with your current
project and all future endeavors.

All of the tasks involved in self publishing from writing
the manuscript to formatting and finally selling your book are detailed in
this guide.
By no means are we able to guarantee your success, but if you follow our
tricks of the trade, we sincerely hope they bring you all the success in the
world. If you’re ready, let’s get started. Together we’ll produce a great
book - well-written, well-made.

- From the Staff at

Throughout this book you’ll see TIP boxes like this one.
In them you’ll find the most common questions, concerns
and fun facts we’ve encountered over the years. Be sure
you take note of them!

PRO TIP
- WHAT IS A PRO TIP?

A copyright page is extremely important for all selfpublishing authors. This lets everyone know that the
contents of your book is your intellectual property - and
yours alone. You want to be sure to include your name,
address, date and copyright symbol at the very least.
If you’ve had your cover art designed, photographed,
or illustrated. Be sure to give credit to your artist; they
deserve the same copyright acknowledgment as you do.
HINT: ALT 0169 will give you the copyright symbol © !

Blitzprint Inc.
Puzzled by Self-Publishing
A Self-Publishing Guide to doing it right the first time.
ISBN: 978-0-9938620-0-7
© Blitzprint Inc. Third Edition 2021
All rights reserved–no part of this book may be reproduced or
transmitted in any form or by any means, electronic or mechanical,
including photocopying, or by any information storage or retrieval
system except for the inclusion of brief quotations in a review, without permission in writing from the publisher.
Blitzprint Inc.
3,1235 64th AVE SE
Calgary AB Canada T2H 2J7
www.blitzprint.com
Cover design, lettering and illustration by Blitzprint Inc.
Printed and Bound in Canada by Blitzprint Inc.
Distributed in Canada by Blitzprint Inc.
© Copyright 2018

PRO TIP
FRONT MATTER

- WHAT IS A COPYRIGHT PAGE?

WE DEDICATE THIS BOOK TO ALL AUTHORS

“Whatever you may have heard, self-publishing is not
a short cut to anything. Except maybe insanity. Selfpublishing, like every other kind of publishing, is hard
work. You don’t wake up one morning good at it. You
have to work for that.”
- Zoe Winters
Smart Self-Publishing: Becoming an Indie Author

The dedication page is for those who deserve a special
thanks, acknowledgment, or other form of appreciation...
This would also be a great spot for a quote, photograph or
illustration.

PRO TIP
- DEDICATION PAGE

PROLOGUE
Blitzprint Inc. is not your average printer. Over our 28 years, we have
made it our mission to marry the finest contemporary printing and bookmanufacturing technologies with the best in traditional, personal service.
We know our clients need the speed, efficiency and high quality of stateof-the-art digital-imaging systems. They also benefit from direct and easy
access to skilled, helpful and enthusiastic people. We know printing. We
know publishing. And we’re delighted to share what we know.
Located in the most advanced colour-digital facility
of its kind in Western Canada, Blitzprint leverages
decades of experience to deliver the highest
standard of colour reproduction. We were the
first company in Canada to offer digital short-run
book printing. Since then we’ve produced more
than 10,000 printed titles, including many bestselling, self-published books. Add to that the repeat
business of more than 75 percent of our clients,
and you’ve got a company that’s earned the trust of
authors and publishers alike.

Here’s the Deal: You retain full
rights to—and control over—your
work, and we’ll supply the right
combination of services, expert
support and ongoing guidance

to help you succeed in the highly
At Blitzprint, you’ll find great people who get a kick
out of having helped thousands of new authors
competitive book marketplace.
from over 50 countries realize their self-publishing
dreams. Our experience has shown us that 99
percent of self-publishing authors simply need
a printer who is dedicated to books. So here’s
the deal: You retain full rights to—and control over—your work, and
we’ll supply the right combination of services, expert support and
ongoing guidance to help you succeed in the highly competitive book
marketplace. Together, we’ll produce a great book—well-written,
well-made.
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THE D.I.Y. PROCESS
TO SELF-PUBLISHING
Well done, you’ve worked long and hard to finish your manuscript, and now it’s time to
turn that stack of paper into a finished book. The world of self-publishing can seem a bit
daunting but at Blitzprint you will always have a real person to talk to that will help guide you
through this process.

THE MANUSCRIPT

DESIGN AND FORMATTING

•

Writing

•

Deciding page size

•

Editing

•

What’s in a page

•

Best font choices

•

Optimal type size

•

Line height

START

•

Ten questions to ask
when selecting a printer

•

Why you should get
an ISBN

•

What you’ll need to get
a quote

•

Copyright page of
your book

•

How much should you
charge for your book?

•

Creating your
barcode

PRINTING QUOTES
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REGISTERING AND OBTAINING ISBN

GETTING YOUR PROOF

GETTING THE WORD OUT

•

Reviewing your pages

•

Promoting your book

•

Checking quality

•

Author websites

•

Making revisons

•

•

Signing off

Book launches and
signings

•

Marketing materials

REPEAT

•

Printing

•

Binding

•

Understanding the
production scheule

An author’s work is
never complete!
Your book will
go through many
stages of shipping,
promoting, reprinting
and new versions
until you move onto
your next book or
project!

UNDERSTANDING THE PRINT RUN
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YOUR FIRST STEPS
THE MANUSCRIPT
Once your manuscript has been written, editing is the
next step. The world’s finest authors rely on skilled
editors, because the best writing always benefits
from a professional editor’s fresh set of eyes. We
can recommend editing professionals and publishing
proofreaders who have the insight, command of
language and literary skills to help you impress book
reviewers and the media.

The best writing always
benefits from a professional
editor’s fresh set of eyes.

EDITORS CANADA
• A content editor will dig into your book and help you Phone: 1 (416) 975-1379
strengthen its structure and development of themes Toll Free: 1 (866) 226 3348
Fax: 1 (416) 975-1637 (Attn: WGA)
and character.
E-mail: info@editors.ca
• A copy editor will make changes to your sentences, www.editors.ca
focusing primarily on grammar, word usage, and
punctuation.
•

A proof reader will double check the text for
typographical, spelling, and formatting errors.

You can find an editor through Editors Canada, the
Writers’ Guild of Alberta, or ask us for a recommendation.
Editors Canada will put you in touch with a variety of
professionals to help you on your journey including
proofreaders, copy editors, translators, and indexers.
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SETTING UP YOUR PRINTING QUOTE
When you are looking for a pricing quote you will need to know what the finished size of
your book will be, the page count of the manuscript and quantity of books you wish to order.
Because your book is now edited you will have a much better idea of this. If you aren’t sure
what size book to go with, visit your local bookstore and look at books in the same genre as
yours. What sizes are most common? What size feels right to you?
Still have questions? Refer to the checklist below to ensure you have all the i’s and t’s crossed
to get the most accurate quote as possible!

SIZE

BIND TYPE
Perfect Bound

4”x7”

5”x8”

8”x8”

8”x10”

5.5”x8.5”

6”x9”

8.5”x11”

LAYOUT ORIENTATION
Portrait

Landscape

Coil

Saddle Stitch

Wire-o

Lithowrap (Hardcover)

Hardcover with Dust Jacket

ADDITONAL SERVICES
Square

PAGE COUNT

Cover Design

Formatting

Hard Copy Proof
Typesetting

Image Scanning

Photo Editing

# of B/W pages:_____________________
# of Color pages:____________________
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DESIGN AND FORMATTING
The old saying of “don’t judge a book by its cover” unfortunately doesn’t
hold true. Many people do select a book based on its appearance. You
worked hard on your book, and now is the time to
make sure your book will appeal to your audience.
Now, think back to the last book you read.
What did the page look like: typeface, margins,
headers, footers, line space kerning... WHAT?!
Okay, okay, we’ll get to that later [See Glossary].

Good design is seamless,
it lets the viewer enjoy your
book without a struggle.

What we’re trying to say is that good design is
seamless, it lets the viewer enjoy your book without
a struggle.
So sit back and enjoy the ride of learning how to turn your manuscript into
a masterpiece!

Your design should speak to the content or subject matter
of your book. Go to the bookstore, local library, or your
own bookshelves and see what others are doing. This will
give you a great starting point to creating a unique layout
for your new book.
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PRO TIP
DESIGN AND FORMATTING

THE BASICS: PAGE OVERVIEW

Header
Chapter Start

Lead Paragraph

Quote

Drop Cap

Body Content

Margin

Ruling line
Page number

Footer
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THE BASICS: PAGE OVERVIEW – DEFINED
THE HEADER
This modern book design omits any
information that usually appears. Although
unusual, the empty header provides a good
use of white space and enhances the overall
book design. Headers often list the title of the
book on the right hand page, and the author’s
name on the left. It is also an option to have
the name of each chapter or section appear
in the header.

THE DROP CAP
Is a large initial letter that drops below the
first line of a paragraph, usually used at
the beginning of a section or chapter of a
book. In this reference we used a display
script typeface for a decorative and elegant
introduction to the paragraph.
BODY CONTENT

References the text that comprises the story
of the book. This is the section where it is
This one has two decorative elements: a pink critical to use an easy-to-read typeface (page
swirl design, and a small capitalized sans 18), appropriate line length (page 21), and
serif. This is one of the many design options easy to view leading (page 22)
that can be used for chapter headings! It’s up
RULING LINE
to you, and your personal style. Note that the
content starts down a few inches from the Straight line used as a border or divider line
top of the page, and the book title has been in a document. A rule line may be employed
omitted from the bottom.
to define a box, panel, or other component of
THE CHAPTER START

a document, as well as to separate the entire
document from its surroundings. A decorative
The lead paragraph is usually not indented. rule line may be used to enhance the design
In this example, we also see a dropped of the document. In this case, a ruling line has
capital letter (drop cap) that complements the been used to separate the footer from the
main content to let the reader know ‘this is
chapter title font.,
the end of the page’.
LEAD PARAGRAPH
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PAGE NUMBER
Usually found in the header or footer, the
page number identifies the page of the book
the reader is on and indicates the sequence
for the table of contents and easy reference.
Page numbers can be used to add flair to the
book without compromising the integrity of
the main content.
FOOTER
A footer complements the design of the book
and can have the same content you would
see in the header as long as it didn’t appear in
the header. It is important to keep this area as
uncluttered as possible for the best reading
experience. This design uses a ruling line
to divide the content, a decorative swirl, the
page number, plus the book title.

MARGIN
This book measures 6”x9” in print, and has
outside margins of 0.6”, top and bottom of
0.5” inch, and an inside margin of 0.6”. This
is the space around the book that gives the
book room to breathe, and makes it printready. If the margins are incorrect you will run
into issues with text being cut off, or going
into the binding. It’s important to consider
this when formatting your book as a printed
book vastly differs from an on screen proof.
QUOTE
To repeat or copy out (a group of words from
a text or speech), typically with an indication
that one is not the original author or speaker.
Quotations can be used in your book as a great
way to break up heavy content. This example
uses phrases directly from her content to
drive emphasis to important pieces. This
allows the reader a chance to have a visual
break, as well as grabbing attention if it’s just
being scanned through by a potential buyer.

Simple is always in style but if you are feeling
adventurous, or want something with a little more flair,
there are tons of tools and designs to make your book
shine. Why not? You’ve already dedicated countless hours
writing your manuscript now show your readers your
passion and excitement.

PRO TIP
DESIGN AND FORMATTING
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THE BASICS: TYPOGRAPHY
WHAT FONT SHOULD I USE?
A question we are asked almost daily here at
Blitzprint and this is the answer, although you
can use anything sitting in your font library,
there are some considerations you should
take into account before choosing “Eccentric”
as your body copy. This is the most important
decision you will make in regards to your
book, but don’t panic - we’re here to help.
The best practice is to keep decorative or
quirky fonts to a minimum. It’ll make when
you do use them more impactful! Play with
titles and page numbers in an irregular style.

Next is the body copy. If you have large
amounts of text, or are looking for a traditional
approach, any of the serifs below will suit your
needs if you’re looking for a more modern or
contemporary novel any of the sans serifs
on page 19 can give you that appearance.
Be sure to note that the typeface you choose
has all the variations you need: bold, semi
bold, italic, light, heavy, condensed.

SERIF: 11/16

Aa Aa Aa Aa Aa
Times New Roman

The quick brown
fox jumped over
the lazy dog.

Georgia

Garamond

Minion Pro

The quick brown
fox jumped over
the lazy dog.

The quick brown
fox jumped over
the lazy dog.

The quick brown
fox jumped over
the lazy dog.

Book Antiqua

The quick
brown fox
jumped over the
lazy dog.

THE SERIF

Serif
18 | Puzzled by Self-Publishing? – A Self-Publishing Guide to Doing it Right the First Time

Serif fonts are easier to read in printed
works. This is because the serif makes
the individual letters more distinctive and
easier for our brains to recognize quickly.
Without the serif, the brain has to spend
longer identifying the letter because the
shape is less distinctive.

THE SANS SERIF

Sans Serif

Sans Serif fonts are better on the web or
used for large headings. A sans serif is
good for small text, emphasis, and when
children are learning to read due to the
simplicity of the shape.

SANS SERIF: 11/16

Aa Aa Aa Aa Aa
Arial

Futura

Gill Sans

The quick brown
fox jumped over
the lazy dog.

The quick brown
fox jumped over
the lazy dog.

The quick brown
fox jumped over
the lazy dog.

When choosing your typeface be sure to take into
consideration what your content is about. Using a
traditional serif typeface may not be the best choice for
say a zombie apocalypse novel. Unless, of course, Jane
Eyre is the one being chased.

Century Gothic

The quick
brown fox
jumped over
the lazy dog.

Calibri

The quick brown
fox jumped over
the lazy dog.

PRO TIP
CHOOSING A TYPEFACE
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THE BASICS: FONT SIZE
An 11 or 12 point font is usually a good size for reading. But every font is different and
different fonts at the same point size may be much larger or smaller than another. Older
readers usually prefer a slightly larger font size, but really large sizes should be used only if
readability for the visually impaired is a concern, or for beginning readers.

Garamond 9pt - Very small for reading, long line lengths.
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice she had peeped into
the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of a book,’ thought Alice ‘without pictures or
conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid), whether the pleasure of
making a daisy-chain would be worth the trouble of getting up and picking the daisies, when suddenly a White Rabbit with pink eyes ran close
by her.

Garamond 10pt - Small for reading, fits a lot of text on the page
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice she had
peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of a book,’ thought
Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid), whether the
pleasure of making a daisy-chain would be worth the trouble of getting up and picking the daisies, when suddenly a White Rabbit

Garamond 11pt - Standard font size, line lengths are not too long.
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of
a book,’ thought Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid),
whether the pleasure of making a daisy-chain would be worth the trouble of getting up and picking the daisies, when

Garamond 12pt - Larger than standard - visually beneficial for older readers.
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once
or twice she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and
what is the use of a book,’ thought Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and

Garamond 16pt - Very Large Text - good for the visually impaired
Alice was beginning to get very tired of sitting by her sister on the bank, and of
having nothing to do: once or twice she had peeped into the book her sister was
reading, but it had no pictures or conversations in it, ‘and what is the use of a
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THE BASICS: LINE LENGTH
When deciding on the size of your book, line length should be a consideration. You will want
to aim to have approx 15 words per line. Long lines cause eye strain, where short lines will
annoy your reader. Remember that the size of your type also dictates the line size. Here we
see examples using 11pt Garamond we think the best situation in this instance is 4.5”, but
what do you prefer?
6.75” Line Length - Garamond 11pt
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of
a book,’ thought Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid),
whether the pleasure of making a daisy-chain would be worth the trouble of getting up and picking the daisies, when
1” Line Length Garamond 11pt
Alice was
beginning to get very
tired of sitting by her
sister on

5.5” Line Length - Garamond 11pt
Alice was beginning to get very tired of sitting by her sister on the bank, and of having
nothing to do: once or twice she had peeped into the book her sister was reading, but it had no
pictures or conversations in it, ‘and what is the use of a book,’ thought Alice ‘without pictures
or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel

2” Line Length - Garamond 11pt

4.5” Line Length - Garamond 11pt

Alice was beginning to get very
tired of sitting by her sister on the
bank, and of having nothing to
do: once or twice she had peeped
into the book her sister was

Alice was beginning to get very tired of sitting by her sister on the bank,
and of having nothing to do: once or twice she had peeped into the book her
sister was reading, but it had no pictures or conversations in it, ‘and what is the
use of a book,’ thought Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot

3.5” Line Length - Garamond 11pt

1.5” Line Length - Garamond 11pt

Alice was beginning to get very tired of sitting by her sister
on the bank, and of having nothing to do: once or twice she
had peeped into the book her sister was reading, but it had no
pictures or conversations in it, ‘and what is the use of a book,’
thought Alice ‘without pictures or conversation?’

Alice was beginning to get very tired
of sitting by her sister on the bank, and of
having nothing to do: once or twice she
had peeped into the book her sister was
reading, but it had no pictures or

5” Line Length - Garamond 11pt
Alice was beginning to get very tired of sitting by her sister on the bank, and of
having nothing to do: once or twice she had peeped into the book her sister was
reading, but it had no pictures or conversations in it, ‘and what is the use of a book,’
thought Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made

1.5” Line Length Garamond 11pt
Alice was beginning
to get very tired of sitting
by her sister on the bank,
and of having nothing
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THE BASICS: LINE SPACING (LEADING)
Leading is the distance between the lines of type. This term came from the days of
typesetting when thin strips of lead were inserted between the lines of type to increase
distance. Please note that larger typefaces and serifs will need more space to breathe.
Here we see leading examples with Garamond 11pt, with various degrees of leading.

Garamond 11pt
1 - This is a large chunk of text creating a thick text box which may be intimidating to the reader.
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of
a book,’ thought Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid),
whether the pleasure of making a daisy-chain would be worth the trouble of getting up and picking the daisies, when
suddenly a White Rabbit with pink eyes ran close by her.
Garamond 11pt
1.15 - Lots of breathing space for the text to be legible and enjoyable to the reader
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of
a book,’ thought Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid),

Garamond 11pt
1.5 - More breathing space for the reader but still enjoyable - will increase page count.
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or twice
she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the use of
a book,’ thought Alice ‘without pictures or conversation?’
   So she was considering in her own mind (as well as she could, for the hot day made her feel very sleepy and stupid),
Garamond 11pt
2 - Too much space between lines; the reader may become annoyed and disregard your book.
Alice was beginning to get very tired of sitting by her sister on the bank, and of having nothing to do: once or
twice she had peeped into the book her sister was reading, but it had no pictures or conversations in it, ‘and what is the
use of a book,’ thought Alice ‘without pictures or conversation?’
22 | Puzzled by Self-Publishing? – A Self-Publishing Guide to Doing it Right the First Time

THE BASICS: CHOOSE YOUR BINDING

1.

2.

1. Perfect Binding: To bind sheets together at the
spine and held to the cover by an adhesive or glue.
Also called soft bind or soft cover.
2. Lithowrap (Hardcover): Hardcover book with
image wrapped directly around the cover.

3.

5.

4.

6.

3. Hardcover with Dust Jacket: Hardcover book
with cloth cover; The jacket is wrapped around a
hardcover book.
4. Plastic Coil: Using a series of plastic coils to bind
multiple sheets of paper together. Useful for cook
books, agendas, or manuals.
5. Coil Bound: Using a series of wire coils to bind
multiple sheets of paper together. Useful for cook
books, agendas, or manuals.
6. Saddle Stitch: Signatures of paper bound
together in middle, or on side with staples.

THE BASICS: CHOOSING YOUR PAPER STOCK
White Offset Stock: This is a popular paper stock and can be used for both text-based and
colour printing. It is available in a 60lb weight for books under 300 pages and 50lb* weight
for books above 300 pages.
Cream Stock: Cream-coloured paper stock is a nice choice for text-based printing. It is not
recommended for colour images as the cream-coloured paper can skew the colour slightly.
Available in a 60lb weight for a page count under 300, and 50lb* weight for books with page
counts above 300.
Enviro-Friendly Stock: Available in white and natural colours it is recommended to be used
for text-based books. The paper is 100% Recycled Content. The paper will contain small
flecks/particles which is due to the recycling process.
White Laser Stock: This paper is recommended for any books that are colour-based. Available
in a variety of paper weights.
*The option of lighter weights for higher page counts reduces the thickness of your book.

Blitzprint inc. | 23

THE BASICS: FORMATTING FOR PRINT
PRINT-READY FILE
A print-ready file is a PDF that is set up for
printing. We print exactly what you send, so
the file must have correct bleed allowances
(.125”), image resolution (300ppi) and colour
space (CMYK). PDFs for book files should be
sent as single page spreads with the press
quality feature on Adobe Reader.

BLEED ALLOWANCE 0.125”
Bleed allowance refers to the part on each
side of the document to give the cutter space
for movement of the paper. Typically artwork
and background colours will extend into this
area to ensure the page will look exactly as
intended by the author. If there is no bleed,
the edge of the paper will have a thin white
line as we cannot guarantee 100% accuracy
during the bindery process.

BEST RESOLUTION: 300 DPI
When inserting images into your book, be
sure to have your images at least 300 dpi
(dots per inch). If the resolution is lower, your
image will appear grainy. It is also important
to note that any images with fine lines, or text
need to be at 600 dpi for maximum image
effectiveness.

MINIMUM MARGINS: 0.5”
To ensure your book prints and binds as
intended, we require a minimum margin of
0.5” with a gutter of 0.25”. Placing text too
close to the edge will result in unforeseen
accidents and errors.

COVER PDF

Covers should be set up to print as a single
PDF that contains front, back, and spine in
one piece, with a .125” bleed, and saved with
SPINE WIDTH
crop marks. If you’re having trouble, Blitzprint
To figure out the spine width you must know would be glad to design a professional cover
the finished page count of your book, and for you.
paper chosen. Use our Free Spine Calculator
on our website for easy reference.
BARCODES
Not all books need barcodes. However, if you
are planning on distributing your book in retail
For best colour reproduction, images should settings, you must have a bar code. If you
be converted into CMYK or Greyscale. choose, we can make a barcode using the
Blitzprint would be happy to convert your ISBN you applied for with your book. Ensure
images for you at a nominal fee. Images that you place your barcode at the bottom left or
are left in RGB can be printed, but there is no right, measuring 1” by 1.75”, at least 0.5” away
guarantee on colour reproduction, or quality from the cut edge and spine.
of the end product.
IMAGE MODE: CMYK
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TUTORIALS
At Blitzprint we understand that formatting can be hard. So we have
created a few simple tutorials to get you started on your way to success!
But, if you’re having trouble, contact one of our book specialists and we’ll
create a solution that works specifically for you.

SETTING YOUR MARGINS
Setting your margins allows for the words
on the page to breathe. It also ensures no
words will end up in the binding or cut off in
the printing process.
•

Go to Page Layout > Page Setup >
Margins tab

•

Go to the Pages section and from the
pull-down menu, select Mirror margins

•

Minimum margins for Top, Bottom is
0.6”, Inside and Outside minimum is 0.5”.
These are the minimums, more space
especially towards the spine is always
better!

•

Gutter is 0.25”

•

In the Orientation section, select Portrait

•

In the Preview section, select Apply to:
Whole Document

•

Click OK.

Margin Tab

Preview Tab

OK - confirms choices
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SETTING YOUR PAGE SIZE
If your manuscript is already written, open a new document in Word to resize your book.
This will ensure you have an untouched back-up copy of your manuscript to reference and
copy and paste from.
•

Go to Page Layout menu > Page Setup, then Paper tab

•

From the Paper size pull-down, select Custom Size

•

Insert the Width and Height; we will typically quote on a 6” x 9” – you will be safe to
design your book at this size; adjustments can be made later.

•

Ignore the Paper source part and leave as the default values.

•

In the Preview section, select Apply to: Whole Document

•

Click OK.
Paper tab
Page Layout Menu

How “Fat”
How “Tall”
Page Setup

Preview Tab

OK - confirms choices
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SETTING LINE SPACING
•

Select the paragraphs for which you want to change the line spacing.

•

On the Home tab, in the Paragraph group, click Line Spacing.

•

Do one of the following:
1) Click the number of line spaces that you want.
2) Open the paragraph style window, click Indents and Spacing, and then select the
options that you want under Spacing.

•

Review your changes, adjust if necessary. Refer to page 22 for help or suggestions on
spacing.

Indents and Spacing Menu

Line Spacing Menu

Line Spacing

OK - confirms choices
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SETTING YOUR CHAPTERS AND HEADINGS
Setting up basic chapter headings is easy with Word. Word has enabled predefined themes
for you to use in the design of your book.
•

Go to the Pages Layout Menu and insert Section breaks between each chapter; This
creates your chapter “sections”.

•

Select your pre-determined theme from the style menu. You can select your fonts and
colors from this menu as well.

•

Go to each chapter, select your heading text and click one of the heading quick styles.
Typically “Heading 1”. Continue this for each chapter.

•

If you have subtitles, select “Subtitle” from the quick style menu.

Page Layout Menu

Breaks Menu
Theme Menu

Quick Style Menu

Heading 1
Subtitle or Heading 2
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CREATING YOUR TABLE OF CONTENTS
The easiest way to create a Table of Contents is to use the built-in heading styles.
•

Ensure you are happy with the formatting of your book. This should be the final stage of
interior formatting.

•

Click where you want to insert the Table of Contents, usually at the beginning of a
document.

•

On the References tab, in the Table of Contents group, click Table of Contents, and then
click the table of contents style that you want.

•

Review the styling of your table of contents and make any adjustments if needed.

References Tab

Table of Contents Menu

Table of Contents Style

Your New Table of Contents
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SAVING A PRINT-READY FILE
Blitzprint uses a PDF (portable document format) workflow. That means we convert all files
to PDF before sending them to press. If you’ve formatted your document on your own and
are satisfied you have print-ready files that will require no further work prior to printing, you
can create the PDF versions yourself.
•

Click the File tab.

•

Click Save As.

•

In the File Name box, enter a name for the file, if you haven’t already.

•

In the Save as type list, click PDF (*.pdf).

•

If the document requires high print quality, click Standard (publishing online and printing).

•

Click Options to set the page to be printed, to choose whether markup should be
printed, and to select output options. Click OK when finished.

•

Click Save.
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CREATING YOUR COVER FILE
To create your cover you must have a front, a back and a spine. To get your spine size visit
our [spine calcuator] at:
www.http://blitzprint.com/author-self-publishing-support/tips-tools/
Our example is 6” x 9” with a 0.625” spine. Created using Adobe InDesign.
•

Create your document as a single page document. Your width will be calculated by
adding your front, back and spine widths together. Your height will be the measurement
of how tall your book is.

•

Add in a 0.125” bleed around your document

•

Place a guide at your first mark (size of back page), place a guide at second mark (size of
back page and spine).

•

Insert images and text to create your desired cover.

•

Save as a High Quality PDF with Bleeds.

Margin

Spine
Bleed
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Spine
Back Cover

Front Cover

Book title: Because it’s cute.

Ectum fugit maximaios eum volumen tiustor rundios estiae
ne saestrum doluptatum fuga. Et magnis consequat exerum

Pudi dis asped min ratem reratati aliqui quate corest, auda
que natum aut ut repudae. Antibusa am quo beribus, omnis
repedio ruptati oratur aditate sit exerum et oditat vent
venist, aborisq uamusae cus veliqui doluptatur ratquosti
cusantus veliquam, cus ullitas sitent evelendicae nem rerro
quo dus, quos qui ipicta dolupis parcia sequis ad quunt
aboresti officii ssequat ionemo occatqui omnis dipisti busande lluptati quam illuptatint aut harum vent.
Sam, vellabo reniment molorunt militemped quatiae re landitae occus, quibus, nihitate etur
alitiusdae numquat empori re laces doloriam quo iuntur arumque cus, tem ut ut ipit, vent quam
conem ut qui amet, earchictorio et que eum quo blaborr oraturit volorporepra videmo consedit
Ficieni blaccus dandiasit moluptaquo berisciis si dolupti onsequos et quae quam et laborum
etur, acculpa quo tem hiliandem et que ipsaecescia quas aut aute seque doloresent poremqu

Book title: Because it’s cute.

natur?

ISBN 978-0-9936404-0-7

www.websiteforbook.com

9 780993 640407

ISBN
Bleed

Trim Size

Shown above: Full colour cover art exported as a High Quality PDF ready for printing. Correct margins and placement has been
established for printing a soft cover 6” x 9” book.

Although Microsoft Word is a great word processor, it is
not the best program in which to build a print-ready cover.
Using a typical layout program such as QuarkXpress,
Adobe InDesign or Adobe lllustrator will create a
professional-looking cover to showcase your book.
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PRO TIP
COVER DESIGN

REGISTERING & ISBN
REGISTRATION & BARCODE

COPYRIGHT

Your book will need an ISBN (International
Standard Book Number) and barcode. The
ISBN is a worldwide identification system used
to register and track your book. The ISBN is
used for book ordering, cataloguing, interlibrary loan, and stock control procedures.

Copyright is the exclusive right to copy a
creative work or allow someone else to do so.
In Canada, a book is automatically protected
by copyright as soon as it is written. You do
not have to register your copyright to have
protection in Canada. However, registering
your copyright through the National Copyright
Office can be useful in the event of a legal
dispute.

Contact the Canadian ISBN Agency at Library
and Archives Canada to get your free ISBN.
CANADIAN ISBN AGENCY
Library and Archives Canada
395 Wellington Street
Ottawa, ON K1A 0N4
Phone: (819) 994 6872
Toll Free: 1 (866) 578-7777
Fax: 819-934-7535
E-mail: BAC.ISBN.LAC@canada.ca
http://www.bac-lac.gc.ca/eng/services/isbncanada/Pages/isbn-canada.aspx

CANADIAN INTELLECTUAL PROPERTY OFFICE
Industry Canada Mail
Place du Portage 1
50 Victoria Street, Rm C-114
Gatineau, QC K1A 0C9
Phone: 1 (866) 997-1936
Fax: 1 (819) 953-2476 (General inquires)
E-mail: ic.contact-contact.ic@canada.ca
www.cipo.ic.gc.ca

DOCUMENT YOUR ISBN NUMBER
-

-

-

-
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THE PRINTING PROCESS
THE PROOF

THE PRESS RUN

After the book and cover have been properly
designed and laid out, the next step is to
proof the book.

Once your proof is approved, we will schedule
the printing and binding of your book’s press
run. If you have a specific date that you need
the books for, please let us know and we’ll
work to meet that deadline.

We offer the option of having a PDF proof to
review or you can also request a printed proof
of your book. This is the time to make final
revisions and corrections. Plan for a week or
two of time for proofing and revisions.

WHAT HAPPENS DURING THE PRESS RUN

START

YOUR ORDER IS
PLACED WITH US

PROOF REVIEWED BY
CLIENT

PRINT READY FILES
SUBMITTED

FILES SENT TO
PRINT

RECREATE NEW FILES
FROM SUGGESTIONS
no

ARE FILES
CORRECT
FOR PRINT?

yes

BOOK BLOCKS &
COVERS CUT DOWN

BOOK PUT THROUGH
THE BINDING MACHINE

BOXING & SHIPPINGS
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GLOSSARY
BIND
Methods that are used to create
a book from individual printed
pages. Methods include but are
not limited to; gluing (perfect
binding), sewn (smyth-sewing),
stapled (saddle stitch), or coil
(plastic or metal spirals). Once
the pages have been bound they
are then attached to the cover.

BLEED
A sheet or page margin trimmed
so as not to mutilate the text or
illustration.

BODY TEXT
Body text is the main portion of
the book or novel excluding the
front and end matter.

BLURB
A promotional description about
the book or author, as found on
jackets of books or on a website.

CMYK
CMYK is a color model in which
all colors are described as a
mixture of these four process
colors. CMYK is the standard
color model used in offset and
digital printing for full-color
documents. Because such
printing uses inks of these four
basic colors, it is often called
four-color printing.

COATED PAPER
Paper that has a coating usually of clay - creating a
smooth and often reflective
surface. Most paper mills
produce coated paper in gloss,
silk and matte.

COVER
Generally a heavy paper stock
that protects the contents of a
book. Parts of a cover include;
Front, Back, Spine, Inside Front,
Inside Back.

CROP MARKS
Marks placed at the corners of
a page or document to indicate
where the page is to be trimmed.

CROPPING
The act of cutting off the
undesired portion of a printed
piece, photograph or book.

DIE
A mold that is used for cutting,
scoring, stamping, embossing,
and debossing. This is usually
created by a block of wood
with metal cut into the desired
design.

DIE CUT
The act of using the die or mold
to remove, emboss, or deboss a
shape into a document.

DPI
DPI is a measurement of printer
resolution that defines how many
dots of ink are placed on the
page when the image is printed.

END SHEET
The sheet that attaches the inside
pages of a hardcover book to the
cover.

FACING PAGES
In a double sided document, the
two pages that appear together
when a document is opened.

FINISH SIZE
The final size of the product after
it has been completed. Also called
trim size.

FORMAT
Size, style, shape, layout or
organization of a layout or printed
piece.

GLOSS
Finish on various materials that
cause light to reflect off the item
(e.g. paper, ink, laminates, UV
coating, varnishes).

GUTTER
The inside margins on a book
used towards the back or
binding.
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HEADER
Content at the top of the page;
usually containing the author’s
name, or title of the book.

ISBN
International Standard Book
Number. A number assigned to a
published work and found on the
copyright page and forms the
barcode.

JUSTIFICATION
The process of setting lines of
type to span the full width of
the paragraph from left to right.
Opposed to ragged right - the
lines do not line up on the right.

JUSTIFIED
Type that has been formatted to
align on both the right and left
side of the paper.

KERNING
Spacing between the individual
characters to create an aesthetic
harmony within a printed piece.

LAMINATE
A thin, transparent plastic
coating applied to paper stock
which provides protection
against liquid, or heavy use.
Found in both gloss and matte
varieties.

LEADING
Term that refers to the spaces
between the lines of text. Usually
referred to as line spacing.

LOW RESOLUTION
Image that is displayed on a
computer display or printed
piece that has a low dpi (usually
under 150 dpi).

MANUSCRIPT
An author’s unformatted and
original form of their work - often
a digital file. Used for submission
in publication.

MARGIN
White space around the
document, or paper.

MATTE FINISH
Flat (not glossy) finish on a
printed piece or document.

MOCK UP
A rough version of a book, with
pasted in images and text.
Used for direction, pacing, and
instruction for complicated
pieces.

PAGE
One side of a leaf, or sheet of
paper in a printed publication.

PAGE COUNT
Total number of pages that a
publication or book will have.

PERFECT BIND
To bind sheets together at the
spine and held to the cover by
an adhesive or glue. Also called
soft bind or soft cover.

PORTRAIT
The orientation of a page or
book that the height is greater
than the width.

PROOF
An early copy of to-bereproduced material produced
as a means of checking for
typos, positional errors, layout
problems and color check.
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RGB
Abbreviation for red, green, blue
- the colors of light. Most digital
images are in this format for
display on computer screens.

SADDLE STITCH
Binding style where sheets of
paper have been printed on both
sides and folded in half to create
four pages. These are then
bound and stapled in the centre.

SPINE
Back or binding edge of a
publication or book.

SPIRAL BIND
Binding using a spiral of
continuous wire or plastic looped
through drilled holes. This is also
referred to as coil or wire-o.

TYPE FAMILY
A group of typefaces created
with a common design. Each
member will have varying
degrees of differences such as
italic, bold, condensed.

TYPOGRAPHY
The process of setting print
quality type. Involves placement,
positioning, and specification
of type to ensure maximum
legibility and aesthetic appeal.

VECTOR GRAPHIC
Image or graphic created by a
digital program not based on
pixels like a photograph. The size
and detail remains on consistent
regardless of the size.

NOTES:

NOTES:

NOTES:

NOTES:
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